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Canopus Proprietary Technology

DVStorm2 is the world’s most capable realtime multi-track editing system. Combining Canopus proprietary 
technologies, DVStorm2 delivers the industry’s highest-quality DV and MPEG, breakthrough realtime 
performance and a professional, stable studio environment.

Unlike any other realtime editing system, DVStorm2 is capable of performing unlimited simultaneous 
realtime video filters, titles and graphics layers. This power and expandability is made possible by Canopus’s 
proprietary scalable video architecture. Pioneered by Canopus in 1998, Scalable Video Technology ensures 
that DVStorm2’s realtime editing capabilities expand as CPU power increases. Scalability ensures a greater 
return on investment and a long product life.

To date, no other editing system offers such scalability.

No Limits Realtime Editing

> 5 simultaneous realtime video tracks.

> Unlimited simultaneous realtime title and graphic layers.

> 30 realtime video filters. 

> 7 realtime audio filters.

> Perspective / 3D picture-in-picture.

> Simultaneous unrestricted combinations for all of the above.

> 28 realtime 2D and 3D transition groups with hundreds of presets.

> Realtime DV and analog output.

> Full YUV editing and processing.

Comprehensive new MPEG capabilities and advanced DVD authoring
> DVStorm2 incorporates a state-of-the-art hardware MPEG-1/MPEG-2 encoder for high-quality archiving of 

video assets and professional DVD publishing.

> Realtime MPEG-1/MPEG-2 capture from an analog or DV source.

> Timeline export to MPEG-1/MPEG-2 with user-definable presets for DVD, SVCD & VCD.

> Encode to CBR, VBR, program stream, elementary stream, MP@ML DVD-compatible encoding

> MpegCutter – Cut, trim and re-export MPEG clips.

> AV Splitter – Create elementary stream from program stream files by splitting audio and video.

> MpegRe-encoder – Reconvert High bitrate MPEG files to lower bitrates at high speed using hardware 
MPEG encoding. 

> MpegExplorer – Allows a detailed view of all MPEG files within a particular folder.

> Ulead DVD Workshop SE – Professional DVD-authoring software.

New Realtime Video Filters
> Mirror

> Raster Scroll

> Tunnel Vision

> Loop Slide

> Strobe

> White Balance / Black Balance filter

Xplode for DVStorm and RT3D-II – Realtime 3D transition software 
> Create unique, stunning and professional video effects.

> 3D Perspective picture-in-picture / Pan & Zoom

Video-out Plug-ins
> Adobe® After Effects® 5.x

> Adobe® Photoshop® 7.x

> NewTek LightWave 3D® 7.0
 

Canopus DV Capture
> Single-pass scene detection and capture / batch capture utility

> Simultaneous 3-stream capture from multiple DV sources. 
(Requires IEEE 1394 Card)

AVI2 Support
> Accelerated timeline output (5x speed)

> Import AVI2 files into Storm Edit or Premiere timeline.

> 5 Realtime video tracks
> 4 Picture-in-picture tracks with zoom

> Realtime blur on the background
      

> 30 Realtime titles and graphic 
layers with motion  and opacity 
effects    

      

> Simultaneous 3-stream capture
      

Powerful New DVStorm2 Capabilities 

Comprehensive new MPEG capabilities and advanced DVD authoring
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Advanced Realtime Video Filters

DVStorm2 features powerful realtime video filters unique to Canopus. All realtime filters are customizable and 
can be combined to provide endless special effects.

30 Realtime Video Filters 
> Anti-flicker

> Blend Effects

> Blur

> Chroma Key

> Chrominance

> Color Correction

> Combine Effects

> Emboss

> High Quality Blur

> Loop Slide

> Luminance Key

> Matrix

> Mirror

> Monochromatic

> Mosaic

> Motion Blur

> Noise

> Old Movie

> Pencil Sketch

> Picture-in-Picture

> Raster Scroll

> Region

> Sharp

> Soft Focus

> Solid Color

> Speed Control (-10,000% to +10,000%)

> Strobe

> Tunnel Vision

> Variable Speed Control

> White / Black balance

Combine Realtime Filters

  

Blend Filters

Realtime Title Motion Filter
Canopus DVStorm2 is capable of unlimited 
simultaneous realtime title and graphic layers. 
Create realtime multi-layered composites with 
dozens of title and graphic layers. Motion and 
opacity control allow each layer to behave 
differently. Title Motion Filter effects include Blur, 
Dissolve, Slide, Wipe and Laser.

> Region Filter
     > Blur
     > Color Correction
    

> Combine Effects
 > Region
 > Color Correction
 > Soft Focus
 > Emboss
 > Pencil Sketch

> Combine Effects
    > Region
    > Color Correction
    > Soft Focus
    > Emboss
    > Pencil Sketch
    > Circular Picture-in-Picture
    > Chroma Key

> Original Video > Chrominance Filter 

> Original Video 

> Original Video > Motion Blur

> Original Video > Tunnel Vision 

> Blur
      

> Monochrome     > Chrominance to 
change the color of 
the car    

> Pencil Sketch
      

> 15 Realtime title 
and graphics layers

> Old Movie & Color  
 Correction

> Old Movie, Color  
 Correction & Region  
 to achieve a 16:9 look 
  

> Combine Effects
 > Region
 > Color Correction
 > Emboss
 

> Original Video 

> Original Video > Old Movie 

Combine and Blend Realtime Filters
There are no limits to the number of Video Filters that can be combined and blended. Canopus Scalable 
Technology allows stacking of video filters on up to 5 Video Tracks all in realtime.
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DVStorm2 now features the industries most flexible 3D Picture-in-Picture handling.
Powerful 3D Picture-in-Picture transition controls include
> Interactive preview tools for position, orientation, scale and shadow configuration.
> Full key frame timeline control for position, orientation, perspective, scale and transparency.

> Crop and Border controls allow separate crop control for each border as well as color and soft edge controls.

> Three interpolation modes: All key frame groups can be interpolated by: Constant, Linear or Spline.

> User friendly configuration controls allow quick configuration of complex transitions without worrying 
about start and end points.

> Extremely high quality anti-aliasing for smooth edges and clear representation of 3D manipulated image borders.

> Easy to use presets provide perfect results without time consuming adjustment. 

Realtime Chroma and Luma Keying

Chroma and luma keying allows editors to make part of their video 
transparent. Keyed clips can be placed over other clips to achieve effects, 
such as placing a person in front of any background video. Canopus 
processes realtime effects in the YUV color space with 4:2:2 sampling. The 
result is a much cleaner Chroma and Luma Key without the compression 
artifacting around the edges normally associated with a Key that works in the 
RGB color space. 

Chroma Key

Luma Key (2 realtime luma keys with 3 realtime video tracks)

Inverted Luma Key (2 realtime luma keys)

> Chroma Key oval 

selection mode

>Video to Key  > Background Video  > Chroma Key Result 1 > Chroma Key Result 2

> Video A to Key  > Video B to Key  > Background > Luma Key Result

> Video to Key  > Background Video   > Luma Key Result > Luma Key Result with the 

        checkerboard rekeyed > 3D Perspective Picture-in-Picture set-up

> Realtime 3D Perspective 
Picture-in-Picture with 
Shine and Border effects

4 3D Picture-in-picture 
> with Highlight 
> with Soft Borders

> with Soft Border
> with Image Cropping 

> with Soft Border

Realtime 3D Picture-in-Picture / 
Pan and Zoom

Realtime Production Studio



8 9

Xplode for DVStorm and 3DRT-II 
Realtime 2D and 3D Transitions 
Canopus DVStorm2 includes Xplode for DVStorm and 3DRT-II,  advanced 3D video effect engines. Xplode for 
DVStorm/3DRT-II feature proprietary Canopus Effects Technology and provide the power to create stunning 
and professional quality video transitions. With 28 transition groups, hundreds of presets and endless 
customizable options Xplode for Storm/3DRT-II provide sophisticated power for the demanding video editor.

> Fly Away > Alpha Wipes - Heart > Cube Spin                       > Twist

Performance at its finest
Xplode for DVStorm plugs-in to Adobe Premiere and Canopus Edit applications to execute multiple complex 
transitions and effects in realtime. 

Create completely original effects
> The Canopus state-of-the-art MPEG Encoder provides output from the timeline 

> Adjust the rate of motion at any point of a transition.

> Save keyframed effects into a preset list.

> Configurable lighting allows editors to adjust where a light source is positioned, what color the light is, and 
the degree of light intensity.

> Within selected transitions, Xplode for DVStorm breaks the barrier of static shadows by providing a very 
natural, realistic and smooth look to projected shadows as they are cast in reference to the direction of the 
incoming light source.

> Import 3D objects from Lightwave and 3D Studio Max. Xplode DVStorm lets users create their own custom-
ized 3D effects. Further customization is possible through the support of AVI, BMP, GIF, Windows Media 
and JPG formats.

Choose from the following Transition Categories which all have 
numerous Presets

> Xplode 3D Standard – Ball Bounce, Billboard, Confetti, Conveyer, Cube Tube, Double Door, Fly Away, Page 
Peel, Ripple, Twist, Wave, Zoom

> Alpha Vapor Dissolves –  Clouds, Smoke and Water

Curtains, Diamonds, Gravel Ring, Hearts Galore, Jaws, Layered Roll On, Mosaic Ripple, Muffins, Oil Slick, 
Quad Spots, Radar, Sandblast, Spiral Burst, Wash Away

3DRT-II Highly optimized 3D DVE’s 
Blinds, Cube Spin, 3D Dissolve, Flip Over, Four Pages, 
Peel Away, Sphere, Single Door, Two Pages

> Xplode transition setup

> Wash Away > Ball Bounce > Alpha Vapor - Changing Wind

> Confetti > Zoom > Alpha Wipes - Spiral in & out   

Canopus Intuitive Interface
Xplode for DVStorm “SmartConfig” intuitive 
interface dramatically reduces the learning curve 
by allowing users to easily and quickly adjust 
transitions to their specific needs

> Blinds > Four Pages

> Sphere> Peel Away

> 3DObject Wipes – Use 3D objects to wipe Video B onto Video A. These include Airliner, Boom Box, 
Butterflies, Camera, Card, Cell Phone, Dice, F16, Golf Ball, Heart, Helicopter, Semi Truck, Sword

> Alpha Wipes – More than 60 different wipes including: Beam Me Up, Breaking Wave, Checker, Circles, 
Curtains, Diamonds, Gravel Ring, Hearts Galore, Jaws, Layered Roll On, Mosaic Ripple, Muffins, Oil Slick, 
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Canopus Realtime Tools

DVStorm2 incorporates an impressive array of professional tools to assist editors in making the best creative 
decisions with their projects. These include a Waveform & Vectorscope monitor, Realtime Audio Filters and 
Realtime video out plug-ins for Adobe After Effects, Adobe Photoshop, and NewTek LightWave 3D. 

Video Tools
Waveform & Vectorscope
Process and maintain the video signal quality necessary for broadcast using 
Canopus’s Waveform and Vectorscope for accurate color information. 
The Waveform and Vectorscope monitors are available for the Color Correction 
and White Balance Filters.The White Balance Filter alters the balance of color using 
the white or black ends of the color spectrum.  

>Waveform > Vector Scope > White Balance > Color Correction 

Realtime Video Out Plug-ins 
Canopus provides Realtime Video Out in Adobe After Effects / Adobe Photoshop / NewTek LightWave 3D. 

Audio Tools
Realtime Audio Tools
Canopus Realtime Audio Filters provide tools such as Graphic Equalizer, Delay, High Pass Filter, Tone 
Controller and more in StormEdit and Adobe Premiere.

Powerful royalty-free music creation
Sonic Foundry ACID Style
ACID Style is a powerful software and loops package that gives you 
everything you need to begin producing royalty-free music.
> Choose from over 600 music loops

> Create tracks using an easy-to-use “pick, paint, and play” style interface

> Use unlimited tracks of audio

> Fly in sound effects, samples, and rhythmic effects

> Save your mix in many popular formats, including MP3, 
RealAudio®, Windows Media™, and WAV

Canopus DVStorm2 incorporates proprietary Canopus Media Technologies for the highest-quality MPEG 
encoding at the fastest speed. DVStorm2 includes MPEG cutting and recompressing utilities for editing files 
that have already been encoded to MPEG.

> MpegCutter – Cut, trim and re-export MPEG clips.

> AV Splitter – Create elementary stream from program stream files by splitting 
audio and video.

> MpegRe-encoder – Reconvert High bitrate MPEG files to lower bitrates at high 
speed using hardware MPEG encoding. 

> MpegExplorer – Allows a detailed view of all MPEG files within a particular folder.

MPEG Encoding and Web Streaming
> The Canopus state-of-the-art MPEG Encoder provides output from the timeline 

to MPEG-1, MPEG-2 (DVD-Compatible), VCD and SVCD with user definable and 
customizable presets.

> Encode using Constant Bit Rate (CBR) or Variable Bit Rate (VBR) to a program 
stream (audio and video together) or elementary stream (separate audio and 
video).

> Web-streaming export to Real Video, Netshow ASF or QuickTime formats using 
Storm Edit or Adobe Premiere.

> Capture directly to MPEG-1, MPEG-2 and VCD from either Analog or DV with 
included MediaCruise application Software.

 

DVD Authoring

DVD production has traditionally been an expensive process 
requiring specialized and dedicated authoring systems

DVStorm2 integrates the power of Realtime DV editing with 
DVD-authoring in a single system solution. Bundled software 
includes Ulead DVD Workshop for outputting sophisticated DVDs, 
VCDs and SVCDs with features such as motion menus, special 
text effects, highlight color customization and photo slide shows 
with still images and audio.

Creating DVDs with DVStorm2 is a snap. Simply encode to 
MPEG-2 from the timeline and import the MPEG-2 files into 
Ulead DVD Workshop for easy and powerful DVD authoring. With 
affordable DVD recorders now available for your desktop PC, DVD 
is the best distribution format available for video.

> Ulead DVD Workshop

MPEG Tools 

Canopus DVStorm2 incorporates proprietary Canopus Media Technologies for the highest-quality MPEG 

> Canopus MPEG 

Encoder options > MediaCruise 

> Canopus MpegCutter

> Sonic Foundry ACID Style
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Product Specifications

> DVStorm PCI bus card

Hardware MPEG Encoding
> Direct realtime capture to MPEG-1 

and MPEG-2 
> MPEG-2 D1, Half-D1 and MPEG-1 encoding 
> Encodes I,P,B frames 

(MP@ML DVD-compatible encoding) 
> Bitrate 1-15Mb/s user adjustable (CBR/VBR) 
> PAL (720x576)/NTSC (720x480), CCIR-601 
> Prefiltering 4:2:2 to 4:2:0 
> Output from StormEdit or 

Adobe Premiere 5.1 timelines.
> Capture with MeidaCruise.
> Specify MPEG output size without 

re-rendering 
> MPEG-1: Elementary and System streams 
> MPEG-2: Elementary and Program streams 
> Audio: PCM WAV or MPEG Layer II

Video Features
> IEEE 1394 (4-pin)
> Composite video (CVBS),  RCA jack
> S-Video (Y/C), mini-DIN
> NTSC and PAL 

> IEEE 1394 (4-pin)
> Composite video (CVBS), RCA jack 
> S-Video (Y/C), mini-DIN
> NTSC and PAL 

> CCIR-601
> NTSC: 720x480 @ 29.97 fps 
> PAL: 720x576 @ 25 fps
> 16:9 support
> DV/DVCAM support 
Full-motion video via hardware overlay supported at 
standard NTSC and PAL frame rates.

Audio Features
> 2-channel 48 kHz 16-bit
> 2-channel 44.1 kHz 16-bit
> 2-channel 32 kHz 16-bit

> Standard RCA pair 

PCI interface

Inputs

    

Outputs

Video Format

Native DV
Audio I/O

Stereo Audio I/O

0 Package Contents

Hardware
> DVStorm PCI bus card
> Installation CD-ROM
> User’s Manual
> IEEE 1394 DV Cable (4pin - 4pin, 2m)
> Stereo pinjack to RCA audio cable
> Composite to S-Video conversion cable

Software
> StormEdit
> Canopus DV Capture
> Canopus Xplode for DVStorm
> Canopus 3DRT-II
> Adobe Premiere Plug-in
> Video out plug-in for Adobe After Effects
> Video out plug-in for Adobe Photoshop
> Video out plug-in for Newtek lightwave 3D
> Canopus MPEG Tools
> Canopus MediaCruise
> Sonic Foundry ACID Style
> Ulead DVD Workshop SE

0 Minimum System Requirements

     (For 1 sec realtime 2D transition + moving title)

> Windows XP Home / XP Professional / 2000
> Intel Pentium III or AMD Athlon processor 700MHz 

or higher*
> 1 free PCI slot
> 256MB RAM
> AV-Rated video storage (10MB/sec minimum sus-

tained transfer)
> 24bit or 32bit graphics card with hardware 

DirectDraw overlay at 1024x768 resolution
 *See our website for system performance matrix

 

0 Service and Support
> Three-year limited warranty

0 Product Specifications

Specifications

DVStormSE customers can upgrade to the full DVStorm2 feature set.

For full details visit www.canopus.com
Some realtime features require Adobe Premiere 6.5

© 2002 Canopus Corporation. All rights reserved. The Canopus logo and DVStorm2 are trademarks of Canopus Corporation. 
All other trademarks are properties of their respective holders. All specifications are subject to change without notice.
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